
PERATURAN BADAN METEOROLOGI, KLIMATOLOGI, DAN GEOFISIKA 
NOMOR 5 TAHUN 2024 

TENTANG 
PENGAMATAN DAN PENGELOLAAN DATA KEMAGNETAN BUMI  

 
DENGAN RAHMAT TUHAN YANG MAHA ESA 

 
KEPALA BADAN METEOROLOGI, KLIMATOLOGI, DAN GEOFISIKA, 

 

 
Menimbang : bahwa untuk melaksanakan ketentuan Pasal 21, Pasal 24, 

Pasal 35, dan Pasal 50 ayat (2) Peraturan Pemerintah Nomor 
46 Tahun 2012 tentang Penyelenggaraan Pengamatan dan 

Pengelolaan Data Meteorologi, Klimatologi, dan Geofisika, 
perlu menetapkan Peraturan Badan Meteorologi, Klimatologi, 
dan Geofisika tentang Pengamatan dan Pengelolaan Data 

Kemagnetan Bumi; 
 

Mengingat : 1. Undang-Undang Nomor 31 Tahun 2009 tentang 
Meteorologi, Klimatologi, dan Geofisika (Lembaran 

Negara Republik Indonesia Tahun 2009 Nomor 139, 
Tambahan Lembaran Negera Republik Indonesia Nomor 
5058); 

2. Peraturan Pemerintah Nomor 46 Tahun 2012 tentang 
Penyelenggaraan Pengamatan dan Pengelolaan Data 

Meteorologi, Klimatologi, dan Geofisika (Lembaran 
Negara Republik Indonesia Tahun 2012 Nomor 139, 

Tambahan Lembaran Negara Republik Indonesia Nomor 
5304); 

3. Peraturan Presiden Nomor 12 Tahun 2024 tentang 

Badan Meteorologi, Klimatologi, dan Geofisika 
(Lembaran Negara Republik Indonesia Tahun 2024 

Nomor 25); 
4. Peraturan Badan Meteorologi, Klimatologi, dan 

Geofisika Nomor 6 Tahun 2020 tentang Organisasi dan 
Tata Kerja Balai Besar Meteorologi, Klimatologi, dan 
Geofisika, Stasiun Meteorologi, Stasiun Klimatologi, dan 

Stasiun Geofisika (Berita Negara Republik Indonesia 
Tahun 2020 Nomor 1371) sebagaimana telah diubah 

dengan Peraturan Badan Meteorologi, Klimatologi, dan 
Geofisika Nomor 4 Tahun 2023 tentang Perubahan 

Kedua atas Peraturan Badan Meteorologi, Klimatologi, 
dan Geofisika Nomor 6 Tahun 2020 tentang Organisasi 
dan Tata Kerja Balai Besar Meteorologi, Klimatologi, dan 

Geofisika, Stasiun Meteorologi, Stasiun Klimatologi, dan 



Stasiun Geofisika (Berita Negara Republik Indonesia 

Tahun 2023 Nomor 857); 
5. Peraturan Badan Meteorologi, Klimatologi, dan 

Geofisika Nomor 2 Tahun 2024 tentang Organisasi dan 
Tata Kerja Badan Meteorologi, Klimatologi, dan 

Geofisika (Berita Negara Republik Indonesia Tahun 
2024 Nomor 365); 

 
MEMUTUSKAN: 

 

Menetapkan : PERATURAN BADAN METEOROLOGI, KLIMATOLOGI, DAN 
GEOFISIKA TENTANG PENGAMATAN DAN PENGELOLAAN 

DATA KEMAGNETAN BUMI. 
 

BAB I 
KETENTUAN UMUM 

 

Pasal 1 
Dalam Peraturan Badan ini yang dimaksud dengan: 

1. Pengamatan Kemagnetan Bumi adalah kegiatan berupa 
pengukuran dan/atau pencatatan/perekaman nilai 

komponen medan magnet bumi. 
2. Pengelolaan Data adalah serangkaian perlakuan terhadap 

Data. 

3. Badan adalah instansi pemerintah yang bertugas dan 
bertanggung jawab di bidang meteorologi, klimatologi, dan 

geofisika. 
4. Unit Pelaksana Teknis Pengamatan Kemagnetan Bumi yang 

selanjutnya disebut UPT adalah unit pelaksana teknis yang 
bertugas dan bertanggung jawab langsung dalam 
pengamatan, pengolahan, dan pelaporan data magnet 

bumi. 
5. Stasiun Pengamatan Kemagnetan Bumi adalah tempat 

dilakukannya pengamatan kemagnetan bumi. 
 

Pasal 2 
Ruang lingkup Peraturan Badan ini meliputi: 
a. Pengamatan Kemagnetan Bumi; 

b. Pengelolaan Data; dan 
c. Pelaporan. 

 
BAB II 

PENGAMATAN KEMAGNETAN BUMI 
 

Pasal 3 

Pengamatan Kemagnetan Bumi dilakukan oleh: 
a. Badan; dan 

b. selain Badan. 
 

Pasal 4 
Pengamatan Kemagnetan Bumi sebagaimana dimaksud dalam 
Pasal 3 dilakukan di: 

a. Stasiun Pengamatan Kemagnetan Bumi; dan 
b. kapal dengan ukuran tertentu atau pesawat terbang 

Indonesia yang memiliki peralatan Pengamatan 
Kemagnetan Bumi. 
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Pasal 5 
Pengamatan Kemagnetan Bumi oleh Badan sebagaimana 

dimaksud dalam Pasal 3 huruf a dilaksanakan oleh Deputi 
Bidang Geofisika dan/atau UPT. 

 
Pasal 6 

UPT sebagaimana dimaksud dalam Pasal 5 ditetapkan oleh 
Kepala Badan. 

 

Pasal 7 
Pengamatan Kemagnetan Bumi sebagaimana dimaksud dalam 

Pasal 5 dilaksanakan paling sedikit untuk memperoleh data: 
a. nilai garis dasar magnet bumi;  

b. variasi kemagnetan bumi; 
c. badai matahari; 
d. prekursor atau tanda awal gempa bumi; dan 

e. pemodelan kemagnetan bumi. 
 

Pasal 8 
Pengamatan Kemagnetan Bumi yang dilakukan oleh selain 

Badan sebagaimana dimaksud dalam Pasal 3 huruf b 
dilakukan oleh: 
a. instansi pemerintah;  

b. badan usaha; 
c. badan hukum; dan/atau  

d. masyarakat, 
sesuai dengan ketentuan peraturan perundang-undangan. 

 
Pasal 9 

(1) Pengamatan sebagaimana dimaksud dalam Pasal 3 

dilakukan oleh petugas. 
(2) Petugas sebagaimana dimaksud pada ayat (1) harus 

memiliki sertifikat kompetensi Pengamatan Kemagnetan 
Bumi. 

(3) Ketentuan mengenai tata cara memperoleh sertifikat 
kompetensi sebagaimana dimaksud pada ayat (2) diatur 
dengan Peraturan Badan.  

 
Pasal 10 

Metode Pengamatan Kemagnetan Bumi sebagaimana dimaksud 
dalam Pasal 3 dilakukan paling sedikit berdasarkan: 

a. peralatan pengamatan; 
b. waktu pengamatan; dan 
c. lokasi pengamatan. 

 
Pasal 11 

(1) Pengamatan Kemagnetan Bumi sebagaimana dimaksud 
dalam Pasal 3 dilakukan dengan menggunakan peralatan 

pengamatan. 
(2) Daftar peralatan pengamatan sebagaimana dimaksud 

pada ayat (1) ditetapkan oleh Kepala Badan. 
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Pasal 12 

Setiap peralatan pengamatan sebagaimana dimaksud dalam 
Pasal 11 ayat (1) harus dilakukan pemeliharaan sesuai dengan 

ketentuan peraturan perundang-undangan.  
 

Pasal 13 
(1) Peralatan pengamatan sebagaimana dimaksud dalam 

Pasal 11 ayat (1) harus laik operasi. 
(2) Laik operasi sebagaimana dimaksud pada ayat (1) 

dilakukan dengan kalibrasi sesuai dengan ketentuan 

peraturan perundang-undangan. 
 

Pasal 14 
Pengamatan Kemagnetan Bumi sebagaimana dimaksud dalam 

Pasal 3 dilaksanakan pada waktu yang meliputi: 
a. Pengamatan Kemagnetan Bumi waktu nyata; 
b. Pengamatan Kemagnetan Bumi mingguan;  

c. Pengamatan Kemagnetan Bumi tahunan; dan/atau 
d. Pengamatan Kemagnetan Bumi waktu tertentu. 

 
Pasal 15 

Pengamatan Kemagnetan Bumi waktu nyata sebagaimana 
dimaksud dalam Pasal 14 huruf a dilaksanakan secara waktu 
nyata selama 24 (dua puluh empat) jam perhari dalam 7 (tujuh) 

hari terus menerus dan berkelanjutan menggunakan peralatan 
otomatis. 

 
Pasal 16 

(1) Pengamatan Kemagnetan Bumi mingguan sebagaimana 
dimaksud dalam Pasal 14 huruf b dilaksanakan setiap 
hari Rabu dan hari Jumat secara manual. 

(2) Pengamatan Kemagnetan Bumi mingguan sebagaimana 
dimaksud dalam Pasal 14 huruf b dilaksanakan pada pagi 

hari antara pukul 08.00 sampai dengan pukul 11.00 
waktu setempat. 

(3) Dalam hal Pengamatan Kemagnetan Bumi mingguan 
sebagaimana dimaksud pada ayat (1) tidak menghasilkan 
data yang baik, akurat, dan/atau sesuai standar data 

magnet bumi maka pengamatan mingguan wajib diulang 
pada sore harinya mulai pukul 14.00 sampai dengan 

pukul 17.00 waktu setempat. 
(4) Hasil Pengamatan Kemagnetan Bumi mingguan wajib 

dikirim setelah pelaksanaan pengamatan ke unit kerja 
yang bertanggung jawab melakukan manajemen mutu 
data magnet bumi pada Deputi Bidang Geofisika. 

 
Pasal 17 

(1) Pengamatan Kemagnetan Bumi tahunan sebagaimana 
dimaksud dalam Pasal 14 huruf c merupakan pengamatan 

lapangan yang dilaksanakan paling sedikit 5 (lima) tahun 
sekali secara manual di titik lokasi yang tetap. 

(2) Lokasi pengamatan lapangan sebagaimana dimaksud 

pada ayat (1) merupakan area, lokasi, daerah yang 
terbuka, dan paling sedikit mengalami gangguan medan 

magnet. 
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(3) Dalam hal titik lokasi sebagaimana dimaksud pada ayat 

(1) sudah tidak sesuai dengan ketentuan sebagaimana 
dimaksud pada ayat (2) dilakukan perpindahan lokasi 

pengamatan. 
 

Pasal 18  
Pengamatan waktu tertentu sebagaimana dimaksud dalam 

Pasal 14 huruf d merupakan pengamatan yang dilakukan di 
lokasi dan waktu yang telah ditentukan dengan tujuan tertentu 
sesuai dengan permintaan khusus dari: 

a. instansi pemerintah; 
b. badan usaha; 

c. badan hukum; dan/atau 
d. masyarakat. 

 
Pasal 19 

Tata cara Pengamatan Kemagnetan Bumi dengan 

menggunakan peralatan pengamatan sebagaimana dimaksud 
dalam Pasal 11 ayat (1) tercantum dalam Lampiran I yang 

merupakan bagian tidak terpisahkan dari Peraturan Badan ini.  
 

BAB III 
PENGELOLAAN DATA KEMAGNETAN BUMI 

 

Pasal 20 
Pengelolaan Data dilakukan untuk menghasilkan informasi 

magnet bumi yang cepat, tepat, akurat, luas cakupannya, dan 
mudah dipahami serta berkelanjutan. 

 
Pasal 21 

(1) Pengelolaan Data sebagaimana dimaksud dalam Pasal 20 

dilakukan oleh petugas. 
(2) Petugas sebagaimana dimaksud pada ayat (1) harus 

memiliki sertifikat kompetensi Pengelolaan Data. 
(3) Ketentuan mengenai tata cara memperoleh sertifikat 

kompetensi Pengelolaan Data sebagaimana dimaksud 
pada ayat (2) diatur dengan Peraturan Badan. 

 

Pasal 22 
(1) Pengelolaan Data sebagaimana dimaksud dalam Pasal 20 

meliputi: 
a. pengumpulan data; 

b. pengolahan; 
c. analisis; 
d. penyimpanan; dan 

e. pengaksesan. 
(2) Pengelolaan Data sebagaimana dimaksud pada ayat (1) 

harus dilakukan dengan menggunakan metode 
Pengelolaan Data. 

 
Pasal 23 

(1) Pengumpulan data sebagaimana dimaksud dalam Pasal 

22 ayat (1) huruf a dilakukan oleh Badan. 
(2) Pengumpulan Data sebagaimana dimaksud pada ayat (1) 

dilakukan berdasarkan standar waktu pengumpulan dan 
format. 
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(3) Waktu pengumpulan data sebagaimana dimaksud pada 

ayat (1) meliputi detik, menit, jam, hari, minggu, bulan, 
dan/atau tahun. 

(4) Format sebagaimana dimaksud pada ayat (2) paling sedikit 
memuat:  

a. lokasi pengamatan;  
b. unsur pengamatan;  

c. hasil pengamatan; dan  
d. waktu pengamatan. 

(5) Format sebagaimana dimaksud pada ayat (2) tercantum 

dalam Lampiran II yang merupakan bagian tidak 
terpisahkan dari Peraturan Badan ini. 

 
Pasal 24 

(1) Data hasil pengumpulan sebagaimana dimaksud dalam 
Pasal 23 ayat (1) dilakukan pengolahan berdasarkan 
standar waktu dan metode. 

(2) Waktu sebagaimana dimaksud pada ayat (1) meliputi 
detik, menit, jam, hari, minggu, bulan, dan/atau tahun. 

(3) Standar waktu sebagaimana dimaksud pada ayat (1)  
dilakukan dengan sinkronisasi waktu server network time 

protocol Badan atau media lainnya menggunakan format 
waktu universal terkoordinasi. 

(4) Metode sebagaimana dimaksud pada ayat (1) 

menggunakan metode statistik, metode dinamis, dan/atau 
metode gabungan metode statistik dan metode dinamis. 

 
Pasal 25 

(1) Data hasil pengolahan sebagaimana dimaksud dalam 
Pasal 24 ayat (1) dianalisis untuk menghasilkan informasi 

magnet bumi. 
(2) Analisis data sebagaimana dimaksud pada ayat (1) 

dilakukan berdasarkan standar waktu, ruang, dan 

metode. 
(3) Waktu sebagaimana dimaksud pada ayat (2) meliputi 

detik, menit, jam, hari, minggu, bulan, dan/atau tahun. 
(4) Ruang sebagaimana dimaksud pada ayat (2) meliputi 

lokasi dan/atau wilayah.  
(5) Metode sebagaimana dimaksud pada ayat (2) 

menggunakan metode statistik, metode dinamis, dan/atau 

gabungan metode statistik dan metode dinamis. 
(6) Tata cara analisis data sebagaimana dimaksud pada ayat 

(2) tercantum dalam Lampiran III yang merupakan bagian 
tidak terpisahkan dari Peraturan Badan ini. 

 
Pasal 26 

(1) Penyimpanan Data sebagaimana dimaksud dalam Pasal 

22 ayat (1) huruf d dilakukan berdasarkan metode 
penyimpanan. 

(2) Metode penyimpanan sebagaimana dimaksud pada ayat 
(1) dilakukan dengan menggunakan: 

a. media dalam bentuk softcopy dan hardcopy; 
b. disimpan paling sedikit pada 2 (dua) lokasi yang 

berbeda; dan 

c. teknologi dalam bentuk teknologi digital; dan/atau 
mengikuti perkembangan teknologi. 
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(3) Tata cara penyimpanan sebagaimana dimaksud pada ayat 

(1) dilaksanakan sesuai dengan ketentuan peraturan 
perundang-undangan. 

Pasal 27 
(1) Data hasil pengolahan sebagaimana dimaksud dalam 

Pasal 24 dan data hasil analisis sebagaimana dimaksud 
dalam Pasal 25 dapat diakses oleh instansi pemerintah, 

pemerintah daerah, badan hukum, dan/atau masyarakat 
yang masuk dalam sistem jaringan. 

(2) Pengaksesan data sebagaimana dimaksud pada ayat (1) 

hanya untuk mendukung tugas pokok atau kepentingan 
instansi pemerintah, pemerintah daerah, badan hukum, 

dan/atau masyarakat. 
(3) Tata cara pengaksesan Data sebagaimana dimaksud pada 

ayat (1) dilaksanakan sesuai dengan ketentuan peraturan 
perundang-undangan. 

 

BAB IV 
PELAPORAN 

 
Pasal 28  

(1) Instansi pemerintah, badan usaha, badan hukum, 
dan/atau masyarakat yang melakukan Pengamatan 
Kemagnetan Bumi dan Pengelolaan Data wajib 

menyampaikan laporan kepada Badan. 
(2) Laporan sebagaimana dimaksud pada ayat (1) digunakan 

sebagai bahan pengaturan, pengendalian, dan 
pengawasan. 

 
Pasal 29 

Laporan sebagaimana dimaksud dalam Pasal 28 meliputi: 

a. hasil Pengamatan Kemagnetan Bumi; 
b. hasil pengolahan/pengelolaan data kemagnetan bumi; 

dan/atau 
c. hasil analisis kemagnetan bumi. 

 
Pasal 30 

Periode pelaporan sebagaimana dimaksud dalam Pasal 29 

dilaksanakan: 
a. setiap bulan untuk Pengamatan Kemagnetan Bumi waktu 

nyata; 
b. setiap bulan untuk Pengamatan Kemagnetan Bumi 

mingguan; dan 
c. setiap tahun untuk Pengamatan Kemagnetan Bumi 

tahunan. 

 
Pasal 31 

Laporan sebagaimana dimaksud dalam Pasal 29 disusun 
sesuai dengan format yang tercantum dalam Lampiran IV yang 

merupakan bagian tidak terpisahkan dari Peraturan Badan ini. 
 

BAB V 

KETENTUAN PENUTUP 
 

Pasal 32 
Peraturan Badan ini mulai berlaku pada tanggal diundangkan. 
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Agar setiap orang mengetahui, memerintahkan pengundangan 

Peraturan Badan ini dengan penempatannya dalam Berita 
Negara Republik Indonesia. 

 
 

 Ditetapkan di Jakarta 
 pada tanggal 21 Oktober 2024 

 
 Plt. KEPALA BADAN METEOROLOGI,  
 KLIMATOLOGI, DAN GEOFISIKA, 

 
Œ 

 
DWIKORITA KARNAWATI 

 

Diundangkan di Jakarta 
pada tanggal                Д 

 
PLT. DIREKTUR JENDERAL 
PERATURAN PERUNDANG-UNDANGAN 

KEMENTERIAN HUKUM DAN HAK ASASI MANUSIA 
REPUBLIK INDONESIA, 

 
Ѽ 

 
ASEP N. MULYANA 
 

 
BERITA NEGARA REPUBLIK INDONESIA TAHUN 2024 NOMOR      Ж 
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LAMPIRAN I 

PERATURAN BADAN METEOROLOGI, 
KLIMATOLOGI DAN GEOFISIKA  

REPUBLIK INDONESIA 
NOMOR 5 TAHUN 2024 

TENTANG 
PENGAMATAN DAN PENGELOLAAN 

DATA KEMAGNETAN BUMI 
 

TATA CARA PENGAMATAN KEMAGNETAN BUMI 

 
I. Pengamatan Magnet Bumi Absolut 

A. Persiapan Pengamatan 
1. Petugas melakukan pengecekan ada atau tidak fenomena badai 

magnetik, dengan cara: 
a. Mengecek K-Indeks pada laman Badan; 
b. Jika saat pengamatan absolut terjadi gangguan pada fluxgate 

magnetometer sehingga sulit mendapatkan nilai 0, maka 
mengecek kembali lingkungan sekitar pilar absolut apakah 

terdapat sumber gangguan magnet bumi; dan 
c. Jika tidak ada sumber gangguan magnet bumi di sekitar pilar 

absolut, tetapi masih sulit mendapatkan nilai 0, maka mengecek 
kembali sinyal variometer apakah terdapat badai magnet bumi 

atau tidak. 
2. Petugas melakukan sinkronisasi jam digital dengan waktu pada 

variometer. 

 

B. Levelling Theodolite 
1. Petugas melakukan levelling pada theodolite menggunakan 

gelembung levelling yang panjang di bawah teleskop. Putar badan 
theodolite secara horizontal sampai gelembung tersebut sejajar 

dengan dua sekrup kaki di bawah dasar theodolite. Sesuaikan dua 
sekrup kaki tersebut secara bersamaan, putar salah satu sekrup kaki 

searah jarum jam dan lainnya berlawanan arah jarum jam hingga 
gelembung berada di tengah-tengah skala. 

 
 

 

 

 

 

 

 

 

 

 

Gambar 1. Langkah pertama levelling 
 

2. Petugas memutar badan theodolite secara horizontal sejauh 180°dan 

menunggu gelembung hingga stabil. Petugas mencatat di mana 
gelembung berhenti. Umumnya, gelembung tidak akan berhenti di 

tengah-tengah skala. Hal ini karena gelembung levelling mempunyai 
sebuah error, bahkan ketika theodolite dalam posisi level, gelembung 

tetap memiliki offset. Offset ini adalah error level. Petugas 
menyesuaikan 2 (dua) sekrup kaki yang sama dengan sebelumnya 

hingga gelembung berada setengah jalan seperti Gambar 2. 
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Gambar 2. Langkah kedua levelling 

 
3. Petugas memutar kembali badan theodolite sejauh 180° kembali ke 

posisi awal dan memastikan bahwa gelembung berada pada posisi 

yang sama seperti level error pada langkah 2. Jika tidak, ulangi dari 
langkah pertama, menggunakan posisi gelembung saat ini. 

 

 

 

 

 

 

 

 

  
 

Gambar 3. Langkah ketiga levelling 
 

4. Petugas memutar badan theodolite 90° dan menggunakan sekrup 

kaki ke 3 (tiga) untuk mengatur gelembung pada posisi yang sama 
pada level error pada langkah 3. 

 
 

 

 

 

 

 

 

 

 

 

 

 Gambar 4. Langkah keempat levelling  
 

5. Petugas memutar theodolite 180° dan menunggu gelembung stabil. 
Gelembung seharusnya berada pada posisi level error seperti langkah 

3 dan langkah 4. Jika tidak, ulangi kembali dari step pertama 
menggunakan posisi gelembung saat ini. Dengan mengulangi langkah 

2 hingga langkah 5, hal ini memungkinkan untuk melevelkan 
theodolite sedemikian rupa sehingga gelembung tetap pada posisi 
level error yang sama ketika theodolite diputar 360°. 
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Gambar 5. Langkah kelima levelling. 
 

C. Pembacaan Theodolite 

 

 

 

 

 

 

 

 

 

 

 

 

 Gambar 6. Bagian theodolite Zeiss (sebelah kiri) dan theodolite WILD T1 
(sebelah kanan) 

1. Theodolite Zeiss  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 7. Layar tampilan skala pada theodolite Zeiss 

 

a. Gunakan kenop tengah (CSS) untuk memilih pembacaan skala 
secara horizontal (titik ke arah bawah) atau vertikal (titik ke arah 
atas). Dua skala tersebut dapat dibedakan pada layar pembacaan 

skala. Jika pembacaan horizontal maka layar berwarna biru dan 
jika vertikal layar berwarna kuning. 
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b. Gunakan kenop paling atas pada sisi theodolite (vernier adjust) 
untuk mengatur garis-garis pada skala Vernier. Nilai pada kotak 
sebelah kanan pada layar tampilan skala hanya akan valid ketika 

garis-garis sebelah atas dan bawah pada kotak sebelah bawah 
layar sejajar. 

c. Baca derajat dari kotak sebelah kiri atas pada layar tampilan 
skala. Bacalah angka yang tampil penuh pada kotak. Pada contoh 

Gambar 7, sebagian angka untuk 198 dan seluruh angka untuk 
199 tampil pada kotak. Pembacaan yang benar untuk skala 
derajat pada gambar tersebut yaitu 199°. 

d. Baca nilai puluhan dari menit dari kotak tengah pada layar 
tampilan skala dan baca satuannya pada kotak sebelah kiri di 

bagian kanan. Sehingga pada Gambar 7 nilai menit 
pembacaaannya adalah 28’. 

e. Bacalah detik angka dari garis skala pada kotak sebelah kanan di 
bagian kanan. Nilai detik pembacaan pada Gambar 7 adalah 47”. 

 

2. Theodolite WILD T1 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 8. Layar tampilan skala pada theodolite WILD T1 

 

a. Skala pembacaan horizontal dan vertikal tampil secara 
bersamaan sehingga pemilihan manual diperlukan. Pembacaan 

skala horizontal memiliki warna kuning pada layar dan skala 
vertikal berwarna putih. 

b. Gunakanlah kenop paling atas (vernier adjust) untuk mengatur 
garis tunggal diantara pasangan garis tetap pada skala derajat. 
Nilai skala pada kotak sebelah kanan pada layar akan benar 

ketika garis tunggal ini tepat di posisi tengah. 
c. Baca derajat horizontal pada kotak sebelah kiri bawah atau kotak 

‘Hz’, ketika garis tunggal secara tepat berada di tengah-tengah 
pasangan garis tetap. 

d. Baca menit pembacaan dari kotak sebelah kanan. Sehingga, nilai 
pembacaan pada Gambar 8 yaitu 28’. 

e. Baca detik pembacaan dengan menginterpolasi posisi segitiga 

yang berada pada nilai. Pada Gambar 8, segitiga berada 2/3 
antara 45” dan 48” sehingga nilai pembacaan detik yaitu 47”. 
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D. Penggunaan Theodolite untuk Menentukan Titik yang Sudah Diketahui  

1. Petugas melepaskan klem horizontal dan memutar badan theodolite 
dengan tangan sampai nilai derajat yang diperlukan tampil pada 

kotak sebelah kiri di layar pembacaan skala. 
2. Petugas mengunci kembali theodolite dengan klem horizontal dan 

menggunakan kenop Horizontal Fine Adjust untuk memutar 
theodolite secara halus sampai nilai puluhan dari menit yang 

diperlukan tampil pada salah satu kotak di tengah layar pembacaan 
skala. 

3. Petugas menggunakan kenop teratas pada sisi theodolite atau Vernier 
Adjust untuk mengatur nilai satuan menit dan detik yang diperlukan 

pada kotak sebelah kanan di layar pembacaan skala. 
4. Petugas menggunakan kenop horizontal fine adjust untuk 

mensejajarkan garis-garis yang ada di bawah kotak tengah pada layar 

pembacaan skala. 
5. Petugas mengecek kembali derajat menit, detik dan memastikan 

sesuai dengan nilai yang diperlukan. Jika belum sesuai, maka 
menggunakan horizontal fine adjust untuk memutar theodolite hingga 

sesuai. 
Catatan:  

Untuk mengatur teleskop pada pembacaan vertikal, lakukan prosedur 
yang sama seperti di atas namun gunakan klem vertikal dan vertical fine 
adjust. 

 

E. Penggunaan Theodolite untuk Menentukan Deklinasi dan Inklinasi  
1. Petugas melakukan pembacaan titik tetap dengan cara melepaskan 

kedua klem vertikal dan horizontal theodolite, lalu memutar teleskop 
kurang lebih mengarah ke titik tetap. Telescope sight dapat 

digunakan untuk membidik titik tetap secara kasar. 
2. Petugas mengunci kembali klem theodolite vertikal dan horizontal 

serta menggunakan kenop fine adjustment untuk menyelaraskan 
garis silang pada teleskop ke titik tetap. 

3. Petugas memfokuskan teleskop untuk melihat titik tetap secara jelas 
dengan memfokuskan garis silang menggunakan cincin pemutar 

yang ada di eyepiece teleskop, kemudian menggunakan cincin 
pemutar besar yang ada di badan teleskop untuk memfokuskan 
bidikan titik tetap. 

4. Di atas cemin pada sisi badan theodolite terdapat lingkaran vertikal 
yang menonjol. Jika lingkaran tersebut berada di sebelah kiri ketika 

membidik titik tetap menggunakan teleskop, maka pembacaannya 
disebut circle left (CL). Jika lingkaran tersebut berada di sebelah 

kanan, maka pembacaannya disebut circle right (CR). Baca nilai skala 
dengan pembacaan horizontal seperti yang dijelaskan pada bagian B 

dan asisten pengamat mencatat nilai tersebut pada form 
pengamatan. 

5. Petugas melepaskan klem horizontal dan memutar badan theodolite 
sejauh 180°. 

6. Petugas melepaskan klem vertikal dan membalikkan teleskop 

sehingga teleskop kembali membidik titik tetap, tetapi dengan 
lingkaran vertikal berada di sisi yang berlawanan. Ulangi langkah 1 

sampai dengan 4. 
 

Catatan:  
Tiap set dari CR dan CL dilakukan 1 atau 2 kali dengan segera 
sebelum pembacaan deklinasi dan sekali setelahnya untuk mengecek 

bahwa theodolite tidak bergerak selama dilakukan pengamatan 
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7. Setelah pembacaan titik tetap selesai, lakukan pengukuran deklinasi. 

Hubungkan kabel sensor magnetometer pada theodolite ke kotak 
elektronik dan nyalakan. 

8. Pembacaan komponen West Up (WU). 
a. Petugas melepaskan klem vertikal dan horizontal dan 

mengarahkan teleskop ke arah barat (west) dengan sensor 
magnetometer di atas teleskop dan teleskop dalam keadaan 

level/mendatar; 
b. Pada skala pembacaan vertikal arahkan teleskop pada nilai 90° 

00’ 00’’, menggunakan kenop paling atas pada sisi theodolite 
(vernier adjust) untuk mengatur garis-garis pada skala vernier 

(nilai menit dan detik 00). Pada nilai tersebut teleskop pada posisi 
mendatar; 

c. Petugas mengunci klem vertikal;  

d. Petugas memutar badan theodolite ke kiri atau kanan hingga nilai 
bacaan magnetometer dekat dengan nilai 0, kemudian mengunci 

klem horizontal; 
e. Petugas menggunakan horizonal fine adjust untuk memutar 

theodolite secara halus hingga pembacaan magnetometer 
mendekati nilai 0. Hal ini merupakan kesempatan yang baik 

untuk mengecek noise magnetic karena benda magnetik apapun 
harus berada cukup jauh dari sensor, sehingga tidak mengganggu 

pembacaan pada magnetometer. Ketika sudah stabil, Petugas 
memberikan aba-aba kepada asisten Petugas untuk mencatat 

waktu. 
f. Petugas mencatat jam, menit, dan detiknya dalam UTC (gunakan 

penunjuk waktu/jam yang telah disesuaikan) dan nilai skala 

pembacaan horizontal pada kolom WU pada form pengamatan. 
9. Pembacaan komponen East Down (ED) 

a. Petugas melepaskan klem vertikal dan membalikkan teleskop 
sehingga menghadap ke timur (east) dan sensor magnetometer 

berada di bawah teleskop. Setting pembacaan skala vertikal 
dengan nilai 270° 00’ 00” menggunakan kenop paling atas pada 

sisi theodolite (vernier adjust) untuk mengatur garis-garis pada 
skala vernier (nilai menit dan detik 00);  

b. Petugas mengunci klem vertikal;  
c. Petugas menggunakan horizontal fine adjust untuk memutar 

theodolite secara halus hingga pembacaan magnetometer 
mendekati nilai 0 atau tunggu waktu tepat menunjukan menit 
baru (pada detik 00). Kemudian, Petugas memberikan aba-aba 

kepada Petugas untuk mencatat waktu. 
d. Petugas mencatat jam, menit, dan detiknya dalam UTC waktu 

pengukuran dan nilai skala pembacaan horizontal pada orientasi 
ED. 

10. Pembacaan komponen West Down (WD) 
a. Petugas melepaskan klem horizontal dan memutar theodolite 

sejauh 180° sehingga mendekati arah barat (west) dengan sensor 
magnetometer di bawah teleskop; 

b. Setting nilai skala vertikal 270° 00’ 00” menggunakan kenop paling 

atas pada sisi theodolite (vernier adjust) untuk mengatur garis-
garis pada skala Vernier (nilai menit dan detik 00); 

c. Petugas memutar badan theodolite ke kiri atau kanan hingga nilai 
bacaan magnetometer dekat dengan nilai 0; 

d. Petugas mengunci klem horizontal; 
e. Petugas menggunakan horizontal fine adjust untuk memutar 

theodolite secara halus hingga pembacaan magnetometer 
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mendekati nilai 0 atau tunggu waktu tepat menunjukan menit 

baru (pada detik 00). Kemudian, Petugas memberikan aba-aba 
kepada Petugas untuk mencatat waktu. 

f. Petugas mencatat jam, menit, dan detiknya dalam UTC waktu 
pengukuran dan nilai skala pembacaan horizontal pada orientasi 

WD. 
11. Pembacaan komponen East Up (EU) 

a. Petugas melepaskan klem vertikal dan membalikan teleskop 
sehingga mengarah ke timur (east) dengan sensor magnetometer 
berada di atas teleskop; 

b. Setting pembacaan skala vertikal dengan nilai 90° 00’ 00” 
menggunakan kenop paling atas pada sisi theodolite (vernier 

adjust) untuk mengatur garis-garis pada skala Vernier (nilai menit 
dan detik 00); 

c. Petugas mengunci klem vertikal; 
d. Petugas menggunakan horizontal fine adjust untuk memutar 

theodolite secara halus hingga pembacaan magnetometer 
mendekati nilai 0 atau tunggu waktu tepat menunjukan menit 

baru (pada detik 00). Kemudian, Petugas memberikan aba-aba 
kepada Petugas untuk mencatat waktu. 

e. Petugas mencatat jam, menit, dan detiknya dalam UTC waktu 
pengukuran dan nilai skala pembacaan horisontal pada orientasi 
EU. 

12. Petugas melakukan pengukuran kembali titik tetap dan mencatat 
pada formulir pengamatan. 

13. Petugas menghitung rata-rata dari WU, ED, WD, dan EU untuk 
mendapatkan nilai meridian pertama, kemudian, meridian kedua 

diperoleh dengan menambah atau mengurangi rata-rata tersebut 
dengan 180°. Petugas mencatat nilai meridian tersebut ke formulir 
pengamatan. 

14. Setelah pengukuran deklinasi selesai, selanjutnya Petugas 
melakukan pengukuran inklinasi. 

15. Pembacaan komponen North Up (NU) 
a. Petugas melepaskan klem horizontal dan memutar badan 

theodolite ke arah utara (north) dengan sensor magnetometer 
berada di atas teleskop; 

b. Petugas menggunakan pembacaan skala horizontal dan 

mengarahkan ke nilai pembacaan meridian pertama serta 
gunakan kenop paling atas pada sisi theodolite (vernier adjust) 

untuk mengatur garis-garis pada skala vernier agar nilai menit 
dan detiknya sesuai dengan nilai meridian pertama; 

c. Petugas mengunci klem horizontal; 
d. Petugas melepaskan klem vertikal dan memutar teleskop ke atas 

atau bawah hingga pembacaan magnetometer mendekati nilai 0; 
e. Petugas mengunci klem vertikal; 

f. Petugas menggunakan vertical fine adjust untuk menggerakan 
teleskop secara halus hingga pembacaan magnetometer 
mendekati nilai 0 atau tunggu sampai waktu tepat menunjukan 

menit baru (detik 00), kemudian, Petugas memberikan aba-aba 
kepada Petugas untuk mencatat waktu; 

g. Petugas mencatat jam, menit, dan detiknya dalam UTC waktu 
pengukuran dan nilai skala pembacaan horizontal pada orientasi 

NU (North Up) di formulir pengukuran;  
h. Petugas mengambil data magnetik intensitas total (komponen F) 

dari peralatan PPM overhauser (proton stasioner) pada waktu 
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yang sama dengan pembacaan NU, lalu ditambahkan dengan nilai 

site difference (dapat dilakukan setelah selesai pengukuran). 
16. Pembacaan komponen South Down (SD) 

a. Petugas melepaskan klem vertikal dan membalikkan teleskop 
sehingga menghadap ke selatan dengan sensor magnetometer 

berada dibawah; 
b. Petugas melepaskan klem vertikal dan memutar teleskop ke atas 

atau bawah hingga pembacaan magnetometer mendekati nilai 0;  
c. Petugas mengunci klem vertikal; 

d. Petugas menggunakan vertical fine adjust untuk menggerakan 
teleskop secara halus hingga pembacaan magnetometer 

mendekati nilai 0 atau tunggu sampai waktu tepat menunjukan 
menit baru (detik 00), kemudian, Petugas memberikan aba-aba 
kepada Petugas untuk mencatat waktu. 

e. Petugas mencatat jam, menit, dan detiknya dalam UTC waktu 
pengukuran dan nilai skala pembacaan horisontal pada orientasi 

SD;  
f. Petugas mengambil data magnetik intensitas total (komponen F) 

dari peralatan PPM overhauser (proton stasioner) pada waktu 
yang sama dengan pembacaan SD, lalu ditambahkan dengan nilai 

site difference (dapat dilakukan setelah selesai pengukuran). 
17. Pembacaan komponen North Down (ND) 

a. Petugas melepaskan klem horizontal dan memutar badan 

theodolite sejauh 180° sehingga menghadap utara kembali, 
namun dengan sensor magnetometer berada di bawah; 

b. Petugas menggunakan pembacaan skala horizontal dan 
mengarahkan ke nilai pembacaan meridian kedua, serta 

menggunakan kenop paling atas pada sisi theodolite (vernier 
adjust) untuk membantu mengatur garis-garis pada skala vernier 

agar nilai menit dan detiknya sesuai dengan nilai meridian kedua; 
c. Petugas mengunci klem horizontal; 

d. Petugas melepaskan klem vertikal dan memutar teleskop ke atas 
atau bawah hingga pembacaan magnetometer mendekati nilai 0; 

e. Petugas mengunci klem vertikal; 

f. Petugas menggunakan vertical fine adjust untuk menggerakan 
teleskop secara halus hingga pembacaan magnetometer 

mendekati nilai 0 atau tunggu sampai waktu tepat menunjukan 
menit baru (detik 00), kemudian Petugas memberikan aba-aba 

kepada Petugas untuk mencatat waktu. 
g. Petugas mencatat jam, menit, dan detiknya dalam UTC waktu 

pengukuran dan nilai skala pembacaan horisontal pada orientasi 
ND di formulir pengukuran; 

h. Petugas mengambil data magnetik intensitas total (komponen F) 

dari peralatan PPM overhauser (proton stasioner) pada waktu 
yang sama dengan ND, lalu ditambahkan dengan nilai site 

difference (dapat dilakukan setelah selesai pengukuran). 
18. Pembacaan komponen South Up (SU) 

a. Petugas melepaskan klem vertikal dan membalikkan teleskop 
sehingga menghadap ke selatan dengan sensor magnetometer 

berada di atas; 
b. Petugas melepaskan klem vertikal dan memutar teleskop ke atas 

atau bawah hingga pembacaan magnetometer mendekati nilai 0;  
c. Petugas mengunci klem vertikal; 

d. Petugas menggunakan vertical fine adjust untuk menggerakan 
teleskop secara halus hingga pembacaan magnetometer 
mendekati nilai 0 atau tunggu sampai waktu tepat menunjukan 
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menit baru (detik 00), kemudian, Petugas memberikan aba-aba 

kepada Petugas untuk mencatat waktu. 
e. Petugas mencatat jam, menit, dan detiknya dalam UTC waktu 

pengukuran dan nilai skala pembacaan horisontal pada orientasi 
SU; 

f. Petugas mengambil data magnetik intensitas total (komponen F) 
dari peralatan PPM overhauser (proton stasioner) pada waktu 

yang sama dengan pembacaan SU, lalu ditambahkan dengan nilai 
site difference (dapat dilakukan setelah selesai pengukuran). 

 

F. Pengukuran Site Difference (Pengukuran dilakukan 1 bulan sekali pada 

minggu awal setiap bulannya) 
1. Petugas melepaskan peralatan theodolite DIM dari pilar absolut dan 

meletakkannya secara berjauhan minimal sekitar 5 meter; 
2. Petugas memasang sensor PPM (proton precession magnetometer) 

portable pada tiang/pilar absolut dengan ketinggian yang sama 
dengan posisi theodolite; 

3. Petugas menyalakan peralatan PPM; 
4. Setting waktu dalam format UTC dan melakukan sinkronisasi dengan 

ntp.bmkg.go.id; 
5. Setting cycling pengukuran dengan nilai terendah (1 detik lebih baik); 

6. Setting pengukuran base station; 
7. Petugas memulai pengukuran minimal selama 1 jam; 
8. Setelah selesai, mematikan alat dan melakukan download file hasil 

pengukuran tersebut; 
9. Petugas menghitung selisih nilai medan intensitas total (F) dengan 

cara mengurangkan hasil pengukuran pilar absolut dikurangi data 
overhauser pada waktu yang sama (dalam orde detik). 

 

𝐹𝑑𝑖𝑓𝑓 = 𝑎𝑣𝑒𝑟𝑎𝑔𝑒(𝐹𝑝𝑖𝑙𝑎𝑟(𝑥) − 𝐹𝑜𝑣𝑒𝑟ℎ𝑎𝑢𝑠𝑒𝑟(𝑥)) 

 
 

II. Pembuatan Baseline untuk Data Quasi-Definitive dan/atau Data Definitive 
Magnet Bumi 
Pembuatan baseline untuk quasi-definitive dan/atau data definitive magnet 

bumi dilakukan oleh Petugas dengan rincian sebagai berikut: 
a. Data Provisional menggunakan baseline sementara yang diperoleh 

selama pengamatan 7 (tujuh) hari. 
b. Data Quasi Definitive menggunakan baseline sementara yang diperoleh 

selama pengamatan minimal 3 (tiga) bulan. 
c. Data Definitive menggunakan baseline final yang diperoleh selama 

pengamatan 1 (satu) tahun. 
Berdasarkan rincian tersebut di atas, berikut tata cata pembuatan baseline 

untuk quasi-definitive dan/atau data definitive magnet bumi dilakukan oleh 
Petugas dengan rincian sebagai berikut: 
a. Petugas setelah melakukan penginputan data pengamatan absolut, 

kemudian membuat baseline dengan cara membuka file yang berisi hasil 
pengamatan absolut (PYSTR dengan ekstensi *.txt) dan/atau file baseline 

(ekstensi *.blv) pada program MagPy: Main Menu → File → Open File → 
pilih data. 
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Gambar 9. Load data hasil pengamatan absolut pada program MagPy 

 

b. Tunggu hingga muncul grafik titik-titik pengamatan absolut. 
 

 
 

Gambar 10. Grafik titik-titik pengamatan absolut. 
 

c. Petugas melakukan fitting baseline melalui tab Analysis dan mengklik Fit. 
Tersedia empat macam metode untuk fitting data, yaitu spline, 

polynomial, linear least-squares, dan mean. 
 

 

 

 

 

 

 

 

 

 

 

 

Gambar 11. Metode fitting data 
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d. Menggunakan metode polynomial dan memilih orde polinomialnya. 

Pemilihan orde polinomial harus dilakukan dengan hati-hati agar tidak 
terjadi overfitting atau underfitting. 

 

 
 

 Gambar 12. Contoh baseline overfitting. Baseline tidak stabil dan terlalu 
mengikuti pola perubahan titik-titik pengamatan absolut (data terlalu 

fluktuatif) 
 

 
Gambar 13. Contoh baseline underfitting. Baseline stabil namun tidak 

mengikuti pola perubahan titik-titik pengamatan absolut 
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Gambar 14. Contoh baseline yang baik. Baseline stabil dan mengikuti pola 

perubahan titik-titik pengamatan absolut namun perubahan yang diikuti 
adalah perubahan jangka panjangnya, bukan perubahan dalam jangka 

pendek. 
 

e. Petugas memeriksa logbook, jika terdapat peristiwa atau kegiatan yang 

menyebabkan pergeseran baseline (pemasangan sensor, reorientasi 
sensor, perubahan titik tetap, dan lain-lain), maka membuat 

diskontinuitas baseline dengan memasukkan tanggal dan waktu 
berlakunya baseline (sejak data pertama hingga data terakhir sebelum 

peristiwa terjadi), kemudian mengklik Apply. 

 

 Gambar 15. Membuat diskontinuitas baseline. 
 

Jika terjadi reorientasi sensor pada tanggal 13 Juni 2018 jam 09.00 UTC, 

maka membuat 2 (dua) baseline seperti berikut: 
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Gambar 16. Langkah untuk membuat 2 (dua) baseline. 
 

Hasilnya adalah sebagai berikut:  

 
 Gambar 17. Hasil dari pembuatan dua baseline 

 

Jika fitting baseline dianggap belum baik dan kita ingin me-reset fitting 

baseline, klik tab Data dan klik Restore data. 
f. Jika fitting baseline dianggap sudah baik, simpan data baseline dengan 

cara:  
File → Export data → simpan sebagai file BLV 

 

 
 

Gambar 18. Export data baseline. 
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g. Pembuatan baseline ini harus dilakukan setiap selesai melakukan 

pengamatan absolut dan menginputnya ke dalam program MagPy. 
h. Petugas menyimpan data quasi-definitive dan/atau data definitive, 

dengan cara melakukan load data provisional yakni:  
Main Menu → File → Open File → pilih data dengan ekstensi psec.sec atau 

pmin.min 
i. Pada tab Analysis klik tombol Baseline dan klik Adopt Baseline 

 
 

 
 

 
 
 

 
 

 
 

 
 

 Gambar 19. Adopt Baseline. 
 

Akan muncul window Adopted baseline, klik OK. 

 

 

 

 

 

 

 

 Gambar 20. Tampilan jika hasil adopt baseline berhasil 
 

j. Petugas melakukan koreksi data provisional dengan mengklik tab Data 

dan mengklik “Baseline Corr” maka data akan berubah nilainya. 
k. Sebelum menyimpan data, cek nilai Delta F dengan cara mengklik tab 

Analysis dan mengklik Delta F. Pastikan grafik Delta F tidak membentuk 
trend kenaikan atau penurunan dan nilainya ± 5 nT untuk data menitan 

dan ± 2.5 nT untuk data detikan. 
 

  
 

 
 

 
 

 
 
 

 
 

 
 

Gambar 21. Grafik Delta F 
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l. Petugas menyimpan data dengan cara: File → Export data → pilih format 

IAGA. 
m. Petugas melakukan export data ke folder baru dengan cara: mengklik 

“Change directory” dan pilih folder 
“D:\Database\Tahun\Bulan\IAGA\qsec” untuk data detikan atau 

“D:\Database\Tahun\Bulan\IAGA\qmin” untuk data menitan Quasi 
Definitive, dan folder “D:\Database\Tahun\Bulan\IAGA\dsec” untuk 

data detikan atau “D:\Database\Tahun\Bulan\IAGA\dmin” untuk data 
menitan Definitive. Data yang sudah dimasukan pada folder tersebut 
akan otomatis tersinkron ke server data magnet bumi di Badan. 

n. Petugas mengklik pada bagian Export Options. Pada bagian “Name(s) end 
with..” isikan dengan qmin.min jika data adalah data menitan, dan 

qsec.sec jika data dalam interval sampling satu detik dengan tipe Quasi-
Definitive dan dmin.min atau dsec.sec jika datanya tipe Definitive. 

 
III. Pembuatan Laporan Quality Control Pengamatan Magnet Bumi Absolut 

Badan melakukan quality control pengamatan magnet bumi absolut terhadap 
nilai deklinasi, inklasi, dan medan total magnet dengan rincian sebagai 

berikut: 
a. Sudut Deklinasi (D) yakni sudut antara utara sebenarnya dan jarum 

kompas (utara magnet); 
b. Sudut Inklinasi (I) yakni sudut kemiringan antara jarum kompas dengan 

bidang horizontal; dan 

c. Medan magnet total (F) yakni menunjukkan besarnya medan vektor 
magnet total. 

 
IV. Quality Control Data Hasil Pengamatan Magnet Bumi Absolut  

Quality control dilakukan atas data hasil pengamatan magnet bumi absolut 
yang dikirimkan oleh pihak yang melakukan pengamatan magnet bumi 
absolut. 

Kegiatan quality data dimaksud dilaksakan dengan tata cara sebagai berikut: 
a. Petugas membuka laman monitoring hasil pengamatan magnet bumi 

absolut pada link berikut: http://202.90.198.224:8181/absolute/ 
 

 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

Gambar 22. Laman data hasil pengamatan magnet bumi absolut. 
 

b. Login dengan menggunakan username dan password khusus untuk user 
dari Badan. 

http://202.90.198.224:8181/absolute/
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c. Petugas memilih menu sesuai dengan nama stasiun yang ingin dilakukan 

quality control data hasil pengamatan absolutnya. 
 

 

 Gambar 23. Tampilan menu sesuai dengan nama stasiun. 
 

d. Petugas memastikan bahwa nilai deviasi pengamatan komponen D dan I 

magnet bumi kurang dari 1° dan nilai deviasi pengamatan komponen F 
magnet bumi kurang dari 50 nT.  

e. Apabila nilai komponen D, I dan F tidak memenuhi kriteria sebagaimana 

dimaksud dalam huruf d, maka Petugas menghubungi stasiun yang 
bersangkutan untuk mengulangi pengamatan absolut dan mengirimkan 

kembali data hasil pengamatan absolut pada laman yang dikelola oleh 
Badan. Jika nilai telah memenuhi kriteria, maka quality control data 

selesai. 
 

 
 

Plt. KEPALA BADAN METEOROLOGI,  

KLIMATOLOGI, DAN GEOFISIKA, 
 

Ttd. 
 

DWIKORITA KARNAWATI 
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LAMPIRAN II 

PERATURAN BADAN METEOROLOGI, 
KLIMATOLOGI DAN GEOFISIKA  

REPUBLIK INDONESIA 
NOMOR 5 TAHUN 2024 

TENTANG  
PENGAMATAN DAN PENGELOLAAN 

DATA KEMAGNETAN BUMI 
 

FORMAT PENGUMPULAN DATA 

 
I. Konversi dan Pengiriman Data RAW Variasi Harian Magnet Bumi Menjadi 

Format IAGA-2002 ke Server Badan 
A. Petugas memastikan file IAGA-2002 dengan resolusi 1 detik dan 1 menit 

terbentuk otomatis di folder “D:\Database\Tahun\Bulan\IAGA\vsec” 
untuk data 1 detik, dan folder “D:\Database\Tahun\Bulan\IAGA\vmin” 

untuk data 1 menit. Data ini otomatis terbentuk setiap hari dan unggah 
setiap 5 menit serta telah menggabungkan data variometer dan data 
overhauser menjadi satu file. 

 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

Gambar 1. Folder data IAGA-2002 
 

B. Jika data tidak terbentuk, Petugas melakukan konversi data secara 
manual dengan membuka command prompt, dengan cara: 

1. Data periode detik 
D: → pindah ke drive D. 

Cd programs → pindah ke folder programs di drive D. 
Python to_IAGA_sec.py 0 → konversi ke IAGA-2002 1 detik untuk hari 
ini. 

Python to_IAGA_sec.py 1 → konversi ke IAGA-2002 1 detik data 1 hari 
yang lalu. 

Python to_IAGA_sec.py 2 → konversi ke IAGA-2002 1 detik data 2 hari 
yang lalu. 

Angka di belakang menunjukkan hari ke berapa dari hari ini yang 
akan dikonversi ke format IAGA-2002. Jika lebih dari 2 hari, 
menyesuaikan angka dibelakang dengan selisih hari yang dimaksud. 

2. Data periode menit 
D: → pindah ke drive D. 

Cd programs → pindah ke folder programs di drive D. 
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Python to_IAGA_min.py 0 → konversi ke IAGA-2002 1 menit untuk 

hari ini. 
Python to_IAGA_min.py 1 → konversi ke IAGA-2002 1 menit data 1 

hari yang lalu. 
Python to_IAGA_min.py 2 → konversi ke IAGA-2002 1 menit data 2 

hari yang lalu. 
Angka di belakang menunjukkan hari ke berapa dari hari ini yang 

akan dikonversi ke format IAGA-2002. Jika lebih dari 2 hari, 
menyesuaikan angka dibelakang dengan selisih hari yang dimaksud. 

 

 
 

 
 

 
 
 

 
 

Gambar 2. Proses konversi data. 
 

Output data yang dihasilkan dari proses konversi manual ini memiliki 
direktori yang sama dengan proses konversi otomatis. 

 

C. Proses konversi data variometer ke format 1min, 1s, dan raw berjalan 
otomatis menggunakan Task Scheduler. Jika terjadi kendala seperti 

proses konversi tidak berjalan, maka melakukan konversi secara manual 
menggunakan command prompt dengan cara: 

D: → pindah ke drive D 
cd sync_data → pindah ke folder sync_data di drive D 

python konversi.py 0 → konversi ke format 1min, 1s, dan raw untuk hari 
ini 

python konversi.py 1 → konversi ke format 1min, 1s, dan raw data 1 hari 
yang lalu 
python konversi.py 2 → konversi ke format 1min, 1s, dan raw data 2 hari 

yang lalu 
Angka di belakang menunjukkan hari ke berapa dari hari ini. Jika lebih 

dari 2 hari, menyesuaikan angka dibelakang dengan selisih hari yang 
dimaksud. 

 
D. Proses pengiriman data 1min, 1s, raw, IAGA-2002 1 menit atau IAGA-

2002 1 detik juga berjalan secara otomatis menggunakan Task Scheduler. 

Jika terjadi kendala seperti proses konversi tidak berjalan, maka 
melakukan konversi secara manual menggunakan command prompt 

dengan cara: 
D: → pindah ke drive D 

 cd sync_data → pindah ke folder sync_data di drive D 
 Double klik file upload.bat 

 Catatan: Pastikan file upload.bat tidak teridentifikasi sebagai 
virus/malware oleh antivirus yang terinstall di komputer. 

 
II. Konversi Data Magnet Bumi Format IAGA-2002 Menjadi Format IAFV 

(INTERMAGNET) serta Pembacaan Data Menggunakan Aplikasi GM-

CONVERT dan IMCDVIEW. 
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A. Aplikasi IMCDView yang dimaksud berbasis java dan terhimpun menjadi 

satu bundel installer yang disebut INTERMAGNET Software Installer. 
Adapun INTERMAGNET Software Installer ini (wajib) membutuhkan Java 

SE Development Kit minimal versi 11, sehingga jika belum terpasang di 
Personal Computer (PC), maka INTERMAGNET Software Installer 

sebelumnya tidak akan dapat terpasang (menunjukkan pop-up message 
error). Adapun perangkat lunak Java SE Development Kit versi 11 

tersebut dapat diunduh di halaman berikut :  
https://www.oracle.com/java/technologies/javase/jdk11-archive-

downloads.html 
 

 
 
 

 
 

 
 

 
Gambar 3. Tampilan Website Oracle 

 
Setelah diunduh, maka pasang perangkat lunak Java SE Development Kit 
tersebut ke PC dengan mengikuti prosedur. 

 
B. Petugas menyiapkan file instalasi INTERMAGNET Software Installer dan 

melakukan instalasi aplikasi (jika belum terpasang di PC). Aplikasi 
IMCDView tersedia di laman INTERMAGNET pada halaman berikut:  

https://geomag.bgs.ac.uk/data_service/intermagnet/home.html  
Memilih installer yang mencakup keseluruhan dari aplikasi 

INTERMAGNET yang dibutuhkan (utamanya adalah gm-convert dan 
IMCDView), yakni INTERMAGNET Software Installer : 

 
 
 

 
 

 
 

 
Gambar 4. Unduh INTERMAGNET Software Installer 

 
Jika sudah diunduh, memasang aplikasinya hingga selesai dengan 
mengikuti prosedurnya. Jika sudah terinstal, maka folder instalasinya 

akan berisikan data sebagai berikut: 
 

 
 

 
 
 

 
 

 
 

 
Gambar 5. Tampilan folder perangkat lunak INTERMAGNET Software Installer 

https://www.oracle.com/java/technologies/javase/jdk11-archive-downloads.html
https://www.oracle.com/java/technologies/javase/jdk11-archive-downloads.html
https://geomag.bgs.ac.uk/data_service/intermagnet/home.html
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C. Buka aplikasi “gm_convert-1.6”, klik Next pada langkah 1 seperti di 
bawah ini : 

 
 

 
 

 
 
 

 
 

 
Gambar 6. Langkah 1 penggunaan perangkat lunak gm_convert-1.6 

 
D. Selanjutnya memilih folder yang telah berisikan data magnet definitive 

berformat IAGA-2002, kemudian centang opsi “Select IAGA-2002 format 

files” seperti gambar di bawah ini. Hal ini dilakukan karena Lampiran 
Peraturan Badan ini menjelaskan cara konversi data magnet format 

IAGA-2002 ke format IAF (INTERMAGNET Archive Format). Namun jika 
ingin melakukan konversi dari file dengan format lain, maka centang file 

dengan format yang bersangkutan (misal .cdf, DKA, dll). Kemudian klik 
tombol Next. 

 
 

 
 
 

 
 

 
 

 
 
 

Gambar 7. Langkah 2 penggunaan perangkat lunak gm_convert-1.6. 
 

E. Kemudian, pilihlah file-file data magnet definitive berformat IAGA-2002 
(pada contoh Lampiran Peraturan Badan ini digunakan file IAGA-2002 

per menit berekstensi .dmin) yang akan dikonversikan menjadi file binary 
berformat IAF, kemudian klik Next 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

Gambar 8. Langkah 3 penggunaan perangkat lunak gm_convert-1.6. 
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F. Pilih INTERMAGNET archive (CD/DVD) format pada kolom Output 
Format: 

 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

Gambar 9. Langkah 4 penggunaan perangkat lunak gm_convert-1.6. 
 

Pilih (browse) folder tempat menyimpan file hasil konversinya. Pilih 
persentase banyaknya data yang hilang (missing) yang diizinkan untuk 

dapat dirata-ratakan (secara default 10%). Kemudian pada panel 
INTERMAGNET Archive Format Options, dapat dipilih output yang ingin 

dihasilkan (secara opsional). 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

Gambar 10. Tampilan INTERMAGNET Archive Format Options 
 

Pilihlah opsi As Found in Source Data. Lalu, klik Next. 
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G. Tunggu aplikasi menyelesaikan konversi datanya hingga selesai. 

 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
Gambar 11. Langkah 5 penggunaan perangkat lunak gm_convert-1.6. 

 
H. Selanjutnya, klik Finish 

 
 
 

 
  
 
 
 
 
 
 
 
 
 
 
 

  Gambar 12. Langkah 6 penggunaan software gm_convert-1.6. 
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I. File yang sudah dikonversi akan tersimpan pada folder yang telah dipilih 

sebelumnya (sesuai Langkah 6). 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 

 

Gambar 13. Data terbentuk pada folder yang telah dipilih. 
 

J. File yang telah tersimpan, dapat dibaca atau di-plot menggunakan 
aplikasi IMCDView. Caranya adalah dengan membuka aplikasi IMCDView 

pada folder instalasi INTERMAGNET Software Installer. 
  

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 

 

Gambar 14. Buka software IMCDView 
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K. Setelah dibuka, maka tampilan aplikasinya adalah sebagai berikut. 

 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
Gambar 15. Tampilan awal perangkat lunak IMCDView. 

 
L. Aplikasi IMCDView digunakan untuk melihat grafik variasi medan 

magnet bumi / Indeks K, baik dari data magnet format IAGA-2002, IAF, 

Indeks-K (format DKA), atau format INTERMAGNET lainnya. Untuk dapat 
melihat grafik variasi medan magnet bumi ini, import terlebih dahulu ke 

data dalam aplikasi IMCDView dengan cara Klik Database pada toolbar > 
Pilih Import Data. 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
Gambar 16. Import data untuk melihat grafik variasi harian 
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M. Kemudian, klik Next 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
Gambar 17. Langkah 1 penggunaan perangkat lunak IMCDView. 

 
N. Pilih folder yang berisikan data IAF yang ingin di-import ke dalam aplikasi 

IMCDView ini. 

 
 
 
 
 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
Gambar 18. Langkah 2 penggunaan perangkat lunak IMCDView. 

 

Hasil konversi IAF terletak pada folder yang sama dengan file input-nya. 
Kemudian, klik Next. 
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Gambar 19. Tampilan data format IAGA-2002 dan IAF dalam satu folder. 
 

O. Selanjutnya, melakukan pemilihan data magnet yang akan di-import. 
Pilih dengan cara mencentang file-nya. Semua file magnet berformat 

IAGA-2002 dan IAF di atas telah tercentang otomatis karena pada 
langkah sebelumnya sudah dilakukan cek/centang pada opsi file 

tersebut. Jika sudah dipilih, klik Next. 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
Gambar 20. Langkah 3 penggunaan perangkat lunak IMCDView 

 
P. Kemudian, tunggu sampai proses konversi file selesai (hingga 100%). Klik 

Next 

 
 

 
 

 
 
 

 
 

 
 

 
Gambar 21. Langkah 4 penggunaan perangkat lunak IMCDView 

File berformat IAF hasil konversi 

menggunakan gm-convert 

File berformat IAGA-2002 (.dmin) 

sebelum dikonversi menjadi file 

IAF 
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Q. Lalu, pilih folder tempat penyimpanan data yang akan ditampilkan. 

Centang add data source to main program, agar data masuk ke database 
aplikasi IMCDView. Kemudian, klik Next. 

 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
  

Gambar 22. Langkah 5 penggunaan perangkat lunak IMCDView 

 
R. Selanjutnya, klik Finish 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

Gambar 23. Langkah 6 penggunaan peangkat lunak IMCDView 
 

S. Pada menu utama aplikasi, pilih View > Explorer Window. Pilih direktori 
dari folder yang berisikan data yang muncul pada tab “INTERMAGNET CD 
Explorer” nya. Jika pada tab “INTERMAGNET CD Explorer” belum muncul 
direktori folder menuju file yang telah di-import (seperti di atas), maka 

lakukan penambahan data kembali. 
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Gambar 24. Tampilan ketika belum muncul direktori file yang telah di import 

 
T. Penambahan data IMPORT dapat dilakukan dengan klik Database > 

Select Data Source. Kemudian klik Select Directory. 
 

 
 
 

 
 

 
 

 
 

 
 
 

 
 

 
Gambar 25. Tahapan untuk penambahan data import. 

 
U. Kemudian akan muncul pop-up message dan juga tab baru seperti 

berikut 

 
 

 
 

 
 
 

 
 

 
 

 
 

 
Gambar 26. Tampilan pop-up message 
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Pada Gambar 26 di atas menunjukkan bahwa direktori file Import sudah 

masuk ke dalam database aplikasi IMCDView. Adapun pop-up message 
Database Error List di atas akan menunjukkan pesan error yang kosong 

jika telah sukses dikonversi. Selanjutnya, klik OK. 
 

 
 

 
 

 
 
 

 
 

 
 

 
Gambar 27. Tampilan pop-up message database error list. 

 
V. Ulangi lagi langkah pada huruf S, yakni pilih View > Explorer Window, 

maka data direktori file yang di-import telah muncul pada tab 

“INTERMAGNET CD Explorer”: 
 

 
 

 
 

 
  

Gambar 28. Tampilan tab INTERMAGNET CD Explorer 

 
W. Lakukan breakdown pada direktori penyimpanan 

 
 

 
 

 
 
 

 
 

 
 

 
 

Gambar 29. Tampilan breakdown direktori penyimpanan 

 
Data dengan format IAF akan muncul dengan format SSSDDMMM.bin 

(SSS = Kode stasiun, DD = angka tanggal, MMM = nama singkatan 
bulan). Kemudian data dapat dilihat Grafik per komponennya dengan 

memilih menu Data Plot. Selesai. 
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Gambar 30. Tampilan grafik data magnet bumi. 

 
Catatan: 

Jika lupa akan folder yang berisikan data import, maka dapat 
melakukan scan data magnet yang telah di-import agar secara otomatis 
terinput dengan cara klik menu View > Database Explorer dari aplikasi 

IMCDView. Scan data dapat dilakukan pada awal aplikasi dibuka 
(startup) berikut 

 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

Gambar 31. Tampilan untuk melakukan scan data 

 

Plt. KEPALA BADAN METEOROLOGI,  

KLIMATOLOGI, DAN GEOFISIKA, 
 

Ttd. 

 
DWIKORITA KARNAWATI 
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LAMPIRAN III 

PERATURAN BADAN METEOROLOGI, 
KLIMATOLOGI DAN GEOFISIKA 

REPUBLIK INDONESIA 
NOMOR 5 TAHUN 2024 

TENTANG  
PENGAMATAN DAN PENGELOLAAN 

DATA KEMAGNETAN BUMI 
 

TATA CARA ANALISIS DATA KEMAGNETAN BUMI 

 
I. Pembuatan Laporan Quality Control Data Quasi-Definitive dan Data Definitive 

Magnet Bumi. 
A. Load data quasi defitinitive dan atau definitive dengan format IAGA-2002 

ke dalam MagPy dan memastikan tidak ada noise, spike atau jump yang 
masih ada di data tersebut. 

B. Untuk melakukan quality control data baseline, load data dengan format 
BLV dan pastikan tidak ada outlier pada titik-titik pengamatan absolut, 

dan baseline yang terbentuk tidak overfitting atau underfitting. Cek jika 
ada diskontinuitas pada baseline. 

 
 
 

 
 

 
 

 
  

  

  
 

Gambar 32. Contoh baseline overfitting.  
 

 
 
 

Baseline tidak stabil dan terlalu mengikuti pola perubahan titik-titik 
pengamatan absolut (baseline fluktuatif) 

 
 

 
 

 
 
 

 
 

 
 

 
  

Gambar 1. Contoh baseline underfitting.  
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Baseline stabil namun tidak mengikuti pola perubahan titik-titik 

pengamatan absolut 
 

 
 

 
 

 
 
 

  
 

 
 

 
 
 

Gambar 2. Contoh baseline yang baik.  
 

Baseline stabil dan mengikuti pola perubahan titik-titik pengamatan 
absolut namun perubahan yang diikuti adalah perubahan jangka 

panjangnya, bukan perubahan dalam jangka pendek. 
C. Untuk pengiriman data ke INTERMAGNET, ada struktur data yang harus 

diikuti, yakni: 
a. Data magnet bumi definitive satu tahun dengan format IAF 

(Intermagnet Archive Format) yang dibagi menjadi 12 bulan (ada 12 

file dalam satu tahun); 
b. Data baseline tahunan dengan format BLV; 

c. Data rata-rata tahunan dengan format IYFV (Intermagnet Yearmean 
Format Value); 

d. Data K-Indeks satu tahun dengan ekstensi .dka; 
e. File teks berisi informasi metadata stasiun dan peralatan 

pengamatan; 
 Seluruh file dari poin a hingga poin e disatukan dalam satu folder dengan 

nama folder adalah kode stasiun. 
D. Untuk membuat data definitive dengan format IAF, load data magnet 

bumi definitive dengan format IAGA-2022 dan pilih data selama satu 
bulan. 

E. Simpan data dengan cara : 
File →Export data→pilih format IAF lalu klik Write. 

 
 
 
 
 
 
 
 
 
 
 

Gambar 3. Export data menjadi format IAF 
 

Ulangi hal yang sama untuk data pada bulan-bulan berikutnya. 
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F. Setelah data sudah disusun sebagaimana langkah 3, cek data definitive 

tersebut menggunakan MagPy. Klik Extra dan pilih Check Definitive Data 
 

 
 

 
 

 
Gambar 4. Tampilan menu Extra 

 
Pilih folder berisi file-file pada langkah 3. 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

Gambar 5. Tampilan menu Checking definitive data 
 

Lalu Klik Run Check 
G. Proses pengecekan data akan dilakukan dalam beberapa tahap. Pastikan 

tidak ada error pada setiap tahap yang ditandai dengan warna hijau jika 
pada tahap tersebut tidak ada masalah, warna oranye jika terdapat 

peringatan (cek dan catat peringatan yang muncul). Jika ada masalah 
atau data error maka akan muncul warna merah (cek dan catat error yang 
muncul). 

H. Proses pengecekan ini dilakukan dalam tujuh tahap: 
a. Pengecekan folder dan file 

b. Pengecekan file dan informasi header 
c. Pengecekan isi dan konsistensi data menitan 

d. Pengecekan isi dan konsistensi data detikan  
e. Pengecekan baseline 

f. Pengecekan file rata-rata tahunan dan konsistensi dengan metadata 
g. Pengecekan indeks aktivitas kemagnetan bumi 

 
Klik Continue untuk melangkah ke tahap-tahap selanjutnya 
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 Gambar 6. Contoh hasil pengecekan pada data yang baik 
 

 
 

 
 

 

 
 

 
 

 
 
 

 
 

 
 

 
 

Gambar 7. Contoh hasil pengecekan pada data yang terdapat error 

 
I. Hasil pengecekan dapat disimpan dengan klik Save. 

 
II. Pembuatan Laporan Quality Control Data Variasi Harian Magnet Bumi. 

A. Petugas membuka aplikasi Magpy lalu load data baseline dengan format 
BLV  

Main Menu → File → Open File → pilih data baseline (.BLV). 
B. Load data variasi dengan format IAGA-2002 (vsec untuk data 1 second 

dan vmin untuk data 1 menit) di folder 
“D:\Database\Tahun\Bulan\IAGA\vsec” atau 

“D:\Database\Tahun\Bulan\IAGA\vmin”. 
Main Menu → File → Open File → pilih data 
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Gambar 8. Load data variasi pada aplikasi MagPy 
 

C. Petugas melakukan pengecekan jika terdapat data yang mengalami 
gangguan 

 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

  
Gambar 9. Pengecekan data yang mengalami gangguan 

 

D. Petugas menghilangkan data yang terganggu (berupa spike) dengan 
flagging. Klik tab Flag, pilih Flag Outlier lalu masukkan nilai Threshold 

dan lebar window, lalu klik Apply. 
 

 
 

 
 
 

 
 

 
 

Gambar 10. Tools Flag untuk menghilangkan data yang mengalami terganggu 
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E. Tunggu hingga muncul titik kuning pada data yang terganggu. Lalu klik 

Drop Flagged 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Gambar 11. Menghilangkan data yang mengalami terganggu 

 
F. Jika data yang terganggu tidak terpilih secara otomatis, ulangi langkah 

3 dengan mengatur nilai Threshold dan lebar window yang berbeda 
hingga data yang terganggu terpilih untuk dihapus. 
 

 
 

 
 

 
 

 
 
 

 
 

 
 

 
 

Gambar 12. Data yang telah bebas gangguan 

 
G. Jika gangguan data berupa jump, identifikasi besarnya offset di masing-

masing komponen. Ubah tampilan data menjadi komponen XYZ dengan 
klik tab Data dan pada bagian “Select components” klik HDZ kemudian 

klik XYZ. 
 
 

 
 

 
Gambar 13. Pilihan komponen XYZ  

untuk mengubah tampilan data 
 

Berikut contoh data yang teridentifikasi besarnya offset di komponen X 
sebesar 30 nT, komponen Y sebesar -15 nT dan komponen Z sebesar 20 
nT pada tanggal 1 April 2019 mulai dari pukul 09:54:00 UTC hingga 

13:20:00 UTC. 
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Gambar 14. Data yang mengalami gangguan jump 
 

H. Klik tab Analysis dan klik Offsets. Pilih Apply offsets to : timerange dan 

masukkan starting tanggal 1 April 2019 pukul 09:54:00 UTC dan ending 
tanggal 1 April 2019 pukul 13:20:00 UTC. Pada kolom xyz, isikan nilai 

offset sebesar nilai offset pada langkah 7 dikalikan -1. Lalu klik Apply. 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 
 

Gambar 15. Analisis data yang mengalami gangguan jump 
 

I. Tampilan data akan berubah dan data kembali normal. 
 

 
 

 
 
 

 
 

 
 

 
 

  

Gambar 16. Tampilan data yang normal setelah analisis data 
yang mengalami gangguan jump 

 
 

30 nT 

-15 nT 

20 nT 
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J. Jika data yang terganggu berupa random noise dan rentang waktunya 

panjang, zoom pada bagian data yang terganggu 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 Gambar 17. Tampilan data yang mengalami gangguan pada rentang waktu 
yang Panjang 

 
K. Tombol Zoom ada dibagian bawah kiri window aplikasi magpy. 

 
 

 

 
 

  
Gambar 18. Tools Zoom di bagian kiri bawah window 

 
L. Klik Flag Selection, pilih komponen yang akan di tandai dan pilih “3: 

remove data” untuk menghapus bagian tersebut. Pada bagian Comment 
isikan keterangan sumber gangguan data tersebut jika diketahui. Jika 
tidak, isikan “Sumber gangguan tidak diketahui”. Lalu klik Apply. 

 
 

 
 

 
 

 
 

 

 
Gambar 19. Menghapus data yang mengalami gangguan 
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M. Petugas memastikan data pada window yang terpilih tadi berubah warna 

menjadi merah 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

Gambar 20. Tampilan data yang akan dihapus berubah menjadi merah 
 

N. Klik Drop flagged untuk menghapus bagian tersebut. 
 

 
 
 

 
 

 
 

 
 

 
 

 

Gambar 21. Tampilan data yang telah dihapus 
 

O. Jika masih ada bagian data yang mengalami gangguan (random noise), 
ulangilah langkah pada huruf J sampai dengan huruf N.  

P. Jika data sudah bersih, masukkan informasi baseline sementara dengan 
cara klik tab Analysis, kemudian klik tombol Baseline dan klik Adopt 

Baseline. 
 
 

 
 

 
 

 
 
 

 
 

  
  Gambar 22. Memasukkan informasi baseline sementara 
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Q. Akan muncul window Adopted baseline, klik OK. 

 
 

 
  

 
 

 
Gambar 23. Tampilan jika informasi baseline sementara berhasil 

dimasukkan 

 
R. Petugas melakukan koreksi data variasi dengan klik tab Data dan klik 

“Baseline Corr” maka data akan berubah nilainya. 
S. Sebelum menyimpan data, cek nilai Delta F dengan cara klik tab Analysis 

dan klik Delta F. Pastikan grafik Delta F tidak membentuk trend kenaikan 
atau penurunan dan nilainya ± 5 nT untuk data menitan dan ± 2.5 nT 

untuk data detikan.  
 

 
 
 

 
 

 
 

  
  
 

 
 

 
Gambar 24. Pengecekan nilai Delta F sebelum penyimpanan data 

 
T. Simpan data ini dengan cara:  

File → Export data → pilih format IAGA 

U. Export data ke folder baru dengan klik “Change directory” dan pilih folder 
“D:\Database\Tahun\Bulan\IAGA\psec” untuk data detikan atau 

“D:\Database\Tahun\Bulan\IAGA\pmin” untuk data menitan 
 

 
 

 
 

 
 
 

 
 

 
Gambar 25. Penyimpanan data 
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V. Klik pada bagian Export Options. Pada bagian “Name(s) end with..” isikan 

dengan pmin.min jika data adalah data menitan, dan psec.sec jika data 
dalam interval sampling satu detik. 

 
 

 
 

 
 
 

 
 

 
 

 
 

 Gambar 26. Penamaan file yang akan disimpan 

 
W. Klik Apply dan klik Write. 

X. Proses pengecekan atau quality control dan penyimpanan data menjadi 
data provisional (pmin dan psec) ini dilakukan setiap hari, meskipun 

pada data variasi (vsec dan vmin) tidak didapati adanya gangguan. 
Data provisional yang sudah dimasukkan ke folder 

“D:\Database\Tahun\Bulan\IAGA\psec” dan 
“D:\Database\Tahun\Bulan\IAGA\pmin” akan otomatis tersinkron ke 
server data magnet bumi di Badan 

Catatan: Jika sampling rate data overhauser di UPT adalah 1 detik, maka 
data provisional yang diolah adalah data detikan (*.psec) dan menitan 

(*.pmin). Namun, jika sampling rate data overhauser di UPT lebih besar 
dari 1 detik, maka data provisional yang diolah hanya data menitan 

(*.pmin). 
 

III. Pengolahan Data Magnet Bumi Absolut. 
 

A. Instalasi XMAGPY 
1. Petugas memasang program magpy-1.0.0 dengan cara meng-klik 

dua kali pada ikon aplikasi seperti gambar dibawah ini, lalu tunggu 

sampai instalasi selesai. 
 

 
 

 
 

 
 

 

Gambar 27. Pemasangan program magpy 1.0.0.exe 
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2. Petugas melakukan update versi xmagpy ke dalam versi 1.1.6 

dengan cara: 
a. Klik Start Menu → App → Magpy → command  

 
 

 
 

 
 
 

 
 

 
Gambar 28. Update xmagpy ke dalam versi 1.1.6 menggunakan 

command prompt 
 

b. Klik kanan command → run as administrator 
 
 

 
 

 
 

 
 
 

 
Gambar 29. Update xmagpy dengan cara run as administrator 

menu command 
 

c. Ketik perintah berikut “pip install geomagpy==1.1.6” dalam 
command prompt. 

 
 

 
 
 

 
 

 
  

Gambar 30. Update xmagpy dengan cara ketik perintah update 
pada command prompt. 
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B. Penginputan Data Pengamatan Absolut Menggunakan Xmagpy 
1. Petugas membuka program xmagpy melalui start menu, lalu klik 

kanan dan pilih run as administrator. 

 
 

 
 

 
 
 

 
 

 
Gambar 31. Menjalankan aplikasi xmagpy 

 
2. Setelah terbuka maka akan muncul tampilan utama program 

xmagpy, selanjutnya klik Menu Bar DI, kemudian klik Open input 

sheet 
 

 
 

 
 

 
 
 

 
 

 
 

 
 

Gambar 32. Membuka formulir input data. 

 
3. Petugas mengisi metadata pengamatan absolut yang berupa Display 

angle as: decimal / dms, observer (nama pengamat), kode IAGA 
stasiun, dan lainnya seperti gambar berikut: 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
Gambar 33. Formulir input data absolut. 
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Gambar 34. Formulir input data absolut yang telah terisi oleh 

metadata peralatan 
 

4. Petugas mengisi formulir azimuth pertama  

  
Gambar 35. Formulir input azimuth pertama yang terdiri dari 2 (dua) 

formulir pengamatan 
 

5. Petugas mengisi formulir pengamatan deklinasi/horizontal 
 
 

 
 

 
 

 
 
 

 
 

 
 

Gambar 36. Form pengamatan deklinasi yang terdiri dari 2 (dua) 
form pengamatan 

 
6. Petugas mengisi form azimuth kedua 

 
 
 

 
 

Gambar 37. Formulir input azimuth kedua yang terdiri dari 2 (dua) 
form pengamatan. 
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7. Petugas mengisi formulir pengamatan inklinasi/vertical 
 

 
 

 
 

 
 
 

 
 

 
Gambar 38. Form pengamatan inklinasi yang terdiri dari 2 (dua) 

form pengamatan. 
 

8. Petugas mengisi formulir untuk nilai total intensity (F) 
 

 

 
 

 
 

 
  

Gambar 39. Formulir untuk nilai total intensity (F) yang terdiri dari 2 

formulir pengamatan. 
 

9. Petugas mengklik save. Selesai 
 

 
 

  
 

 
 

Gambar 40. Tampilan apabila data pengamatan absolut telah 

tersimpan 
 

C. Pengolahan Data Absolut Menggunakan Xmagpy 
 

1. Pada panel sebelah kanan atas, klik menu DI. 
 
 

 
 

 
 

 
 
 

  
 

 
Gambar 41. (a) Tampilan menu DI. (b) Tampilan menu  

Vario/Scalar 

(a) 

(b) 



- 54 - 

 

2. Klik tombol DI data, arahkan menuju file input yang sudah tersimpan 
sesuai point B. 

 
 

 
 

 
 
 

 
Gambar 42. File input merupakan file yang terbentuk ketika telah 

melakukan prosedur point B 
 

Klik tombol Vario/Scalar, arahkan ke folder di mana kita menyimpan 
data format IAGA-2002 dengan ekstensi kita tulis *.sec untuk format 

data per detik. Kemudian klik continue. 
 

 
Plt. KEPALA BADAN METEOROLOGI,  
KLIMATOLOGI, DAN GEOFISIKA, 

 
Ttd. 

 
DWIKORITA KARNAWATI 
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LAMPIRAN IV 

PERATURAN BADAN METEOROLOGI, 
KLIMATOLOGI DAN GEOFISIKA  

REPUBLIK INDONESIA 
NOMOR 5 TAHUN 2024 

TENTANG PENGAMATAN DAN 
PENGELOLAAN DATA KEMAGNETAN 

BUMI 
 

FORMAT PELAPORAN  

A. DATA MAGNET BUMI HARIAN 

1. Format data dalam bentuk file text / ASCII 
 

2. Data yang harus diisi: 

 

Nama Instansi : diisi dengan nama instansi yang melakukan 

pengamatan magnet bumi 
Lintang : diisi dengan lintang geografis tempat melakukan 

pengukuran 

Bujur : diisi dengan bujur geografis tempat melakukan 
pengukuran 

Elevasi : diisi dengan elevasi tempat melakukan pengukuran 
Tanggal : diisi dengan tanggal pengukuran 

Komponen : diisi dengan komponen magnet bumi yang diukur 
Data : diisi dengan data magnet bumi yang diukur beserta 

waktu dalam UTC 

3. Contoh Laporan: 
Nama Instansi : Universitas Jawa Tengah 

Lintang  : -6.2518 
Bujur  : 102.5684 

Elevasi  : 125 meter 
Tanggal  : 25 Juli 2024 
Komponen  : X, Y, Z, F 

Data   : 
Waktu (UTC)  X  Y  Z  F 

01:00:00  41000.25 210.54  -6521.21 42521.23 
01:01:00  41000.26 210.55  -6521.22 42521.24 

01:02:00  41000.23 210.51  -6521.29 42521.22 
…………………………………………………… 

 

B. DATA MAGNET BUMI ABSOLUT 
1. Format data dalam bentuk file Excel 

 
2. Data pengamatan magnet bumi absolut diisi sesuai dengan form standar 

 

 
3. Data yang diisi antara lain: 

 

Observatorium 

: diisi dengan nama observatorium tempat 

melakukan pengamatan absolut 
Hari dan Tanggal : diisi dengan hari dan tanggal pengamatan 

absolut 
Koordinat : diisi dengan bujur dan lintang 

observatorium tempat melakukan 
pengamatan absolut 
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Pengamat : diisi dengan nama pengamat 

Peralatan 
Pengamatan 

: diisi dengan nama peralatan DIM dan proton 
magnetometer yang digunakan untuk 

pengamatan 
Site Diff | 

Azimuth TT 

: diisi dengan nilai site difference (selisih nilai 

medan magnet total antara pilar pengamatan 
absolut dengan pilar proton magnetometer, 

jika ada) dan azimuth titik tetap 
CR : pembacaan skala horizontal dari titik tetap 

dengan posisi sensor diatas 

CL : pembacaan skala horizontal dari titik tetap 
dengan posisi sensor dibawah 

WU : pembacaan nilai deklinasi pada posisi sensor 
West Up dan waktu dalam UTC 

ED : pembacaan nilai deklinasi pada posisi sensor 
East Down dan waktu dalam UTC 

WD : pembacaan nilai deklinasi pada posisi sensor 

West Down dan waktu dalam UTC 
EU : pembacaan nilai deklinasi pada posisi sensor 

East Up dan waktu dalam UTC 
Meridian 1 : diisi dengan nilai rata-rata pembacaan di 

WU, ED, WD, dan EU 
Meridian 2 : diisi dengan nilai back-azimuth dari 

meridian 1 

NU : pembacaan nilai inklinasi pada posisi sensor 
North Up dan waktu dalam UTC 

SD : pembacaan nilai inklinasi pada posisi sensor 
South Down dan waktu dalam UTC 

ND : pembacaan nilai inklinasi pada posisi sensor 
North Down dan waktu dalam UTC 

SU : pembacaan nilai inklinasi pada posisi sensor 

South Up dan waktu dalam UTC 
F Total : pembacaan nilai medan magnet total dari 

Proton Magnetometer 
 

 
 

*Format terlampir dapat disesuaikan dengan kebutuhan. 
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Form Pengamatan Absolut 
 

Observatorium   : … 
Hari dan Tanggal   : … 

Koordinat    : Lintang … dan Bujur …    
Pengamat    : Mr/Ms. 

Peralatan Pengamatan  : DIM (merk) dan PPM (merk)  
Site Diff | Azimuth TT  :  
  

Deklinasi 

Pembacaan Titik Tahap Awal 

 ° ‘ “  ° ‘ “ 

CR    CL    

Circle Waktu (UTC) 
F Total 

 ° ‘ “ HH MM SS 

WU      00  

ED      00  

WD      00  

EU      00  

 ° ‘ “  ° ‘ “ 

Meridian 1    Meridian 2    

Pembacaan Titik Tetap Akhir 

 ° ‘ “  ° ‘ “ 

CR    CL    

Inklinasi 

Circle Waktu (UTC) 
F Total 

 ° ‘ “ HH MM SS 

NU      00  

SD      00  

ND      00  

SU      00  

 

C. PENGUMPULAN DATA 
Data hasil pengamatan, baik data magnet bumi harian maupun absolut 

dikirimkan berupa lampiran file melalui media email bgp@bmkg.go.id dalam 
kesempatan pertama.  
 

 

*Format terlampir dapat disesuaikan dengan kebutuhan. 

 

Plt. KEPALA BADAN METEOROLOGI,  

KLIMATOLOGI, DAN GEOFISIKA, 
 

Ttd. 
 

DWIKORITA KARNAWATI 
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